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iNTrOduCTiON
About This Program
With four generations in today's workplace, differences in attitudes, values, and 
communication can create misunderstandings and trigger conflicts that reduce morale, 
teamwork, and productivity. But these differences need not be barriers to a bigger bottom line. 
DuPont Sustainable Solutions' Four Generations: The Greatest Potential helps Traditionalists, 
Baby Boomers, Generation X’ers, and Generation Y’ers in your organization bridge the 
generation gap to help improve relationships critical to business and personal growth. Four 
Generations: The Greatest Potential profiles each generation’s attitudes, mindsets and 
values, and helps your employees understand and empathize with colleagues from a different 
generation, reduce and resolve conflicts and communication problems, facilitate better 
teamwork and increase productivity and recognize and respect each other’s value and input.

This Leader’s Guide is designed to help you facilitate a training session on four generations 
in today’s workplace. It offers ideas on how to use this program in different ways, giving your 
organization flexibility to determine which training format is best for its specific needs. The 
program is 22 minutes long. On the DVD, there is an option to show the program in scenes.  
In this Leaders Guide, a quiz is available.

Training Points have been created on the DVD format of this program to provide visual aids 
when sharing important training material, or reviewing content of the program. Video links 
are included to provide visual reinforcement of some of the Training Points. 

A PowerPoint® presentation, identical to the Training Points content of this program, has been 
included in both formats for your use. The customizable version is available for you to add 
specific information for your organization. Tips for customizing this presentation are included 
at the end of this guide. As an alternative, the slide information may be printed or transferred 
to transparency sheets or a flip chart when used in conjunction with the program.

Illustrated handbooks are also available for use with this program. These handbooks may be 
given to participants as a helpful note-taking and reference tool. A quiz is available at the end 
of the handbook. 

We recommend that you tailor the program to your organization’s needs by including specific 
information unique to your employees. The specifics of how you facilitate the program are up 
to you.
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Training Materials
There are a few things you’ll need for an effective training session:

A training room located away from major distractions or interruptions •
A comfortable arrangement of chairs and tables, preferably in a circular pattern, with an  •
opening for a TV monitor and other visual aids. (Be certain all participants can see the 
TV monitor and other visual aids.)
Adequate lighting that can be adjusted while viewing the program •
A location, possibly including a podium and/or a flip chart, from which the trainer/ •
speaker can lead discussion 
The training program  • Four Generations: The Greatest Potential
Television with DVD player or computer with DVD-ROM drive •
Copies of the class agenda  •
A copy of the handbook, paper and pencil for each participant •
A flip chart or dry-erase board and appropriate markers •
A computer with PowerPoint® software and the PowerPoint® Presentation •
Copies of the Quiz and Evaluation. •

Preparation
Preparation is the key to effective training. Do these things prior to the session:

Establish Training Objectives. Determine the training objectives in advance so that you 
can identify the best approach to take for the training session. It is also important to decide 
what level of understanding is expected from participants upon completion of the training. 
Suggested training objectives for this presentation are:

Identify when communication conflicts or misunderstandings are related to different  •
generations.
Develop strategies that facilitate communication across generations. •
Capitalize on generational differences to lead four generations in one direction. •

Feel free to edit the training objectives to meet the particular needs of your organization. 
Training objectives should reflect the content of the program.

Determine the Audience. Another aspect to consider in planning this training session is the 
audience. Tailor your presentation to the skills or experience of the participants. The focus of 
your discussion and the depth of content presented may vary, depending on whether you are 
providing an orientation for new employees, a refresher course for experienced employees or 
a session for your management group. The ideal group size should range between 10 and 20 
people. 

Schedule the equipment. Work closely with the person who will be arranging the room, 
equipment, supplies and participants.

Schedule the time for the course. Participant retention will be greatest in the mornings or 
the beginning of the shift.

PPPRRREEEVVVIIIEEEWWW      

http://www.coastal.com
http://www.coastal.com


4

4

www.coastal.com

www.coastal.com Four Generations: The Greatest Potential

Copyright © Coastal Training Technologies Corp.

Preview the DVD, handouts and Program Outline. Decide how you will show the 
program. Will it be viewed straight through or will you stop for discussion? The Program 
Outline section of this leader’s guide indicates the chapters. 

Familiarize yourself with the TV and DVD/DVD-ROM player so you can avoid having to 
fumble with the controls. 

Decide how you will use the PowerPoint® presentation – you may refer to it at stopping 
points or go through it all at once at the end for review purposes. You may wish to customize 
it and use it as stand-alone training.

Determine organization policy on testing employees. A quiz is provided at the back of 
this leader’s guide, but you may want to consult your organization’s rules prior to using it. 
There is also a 10-question quiz in the employee handbook. Contact DuPont Sustainable 
Solutions if you would like to order additional handbooks.

Rehearse your presentation. Practice using the training aids and conducting any 
demonstrations. Make notes and write down any additional points you plan to discuss.
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Presentation Tips

Overcoming anxiety

The best way to overcome anxiety about speaking before a group is to be prepared. Although 
it’s natural to be nervous, your sweaty palms will disappear once you focus on what you are 
saying. Concentrate on what you want people to understand and your presentation will flow 
naturally.

Choosing your vocabulary

It’s best to use the same comfortable language that you would use when speaking one-on-one. 
Avoid jargon and overly complicated words or phrases.

Getting rid of the “umms”

One of the most annoying mistakes a speaker makes is saying “umm” every time there is a 
break between thoughts. Remain silent while you think about what you’re going to say next. 
The silence will seem longer to you than it will to the audience. If you remember this, you’ll 
feel less pressure to fill the silence. You can control your “umms” by jotting down notes 
beforehand. If you want to include personal anecdotes or examples, write down a few notes 
to trigger your memory. Beware of writing down too much, however. You’ll deliver your 
message to your note cards instead of your audience.

Controlling the speed and tone of your voice

You’ll put your audience to sleep if you speak too slowly, and they won’t be able to keep 
up with the content if you speak too quickly. Approximately 150 words per minute is the 
best speed (that’s about two-thirds of a page, typed, double-spaced). Vary your tone often, 
especially when making an important point. Adding emotion to your presentation will keep 
your audience involved. Again, strive for a conversational tone.

Sticking to the schedule

Begin class on time and restart the session promptly at the end of the break. Except for 
emergencies, participants should not be interrupted for messages.

Asking for questions

Ask for questions throughout the session. Be prepared to answer all types of questions, but 
don’t be worried you don’t know every answer. You can simply say, “Let me find out for you 
and get back to you.” Keep in mind many questions are best answered through discussion. 
An appropriate response might be, “Good question. Let’s hear some discussion on that one.” 
Watch the clock, though. Too many unplanned discussions can eat up your time.
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TraiNiNG SESSiON OVErViEW
Giving the Quiz
Prior to the session, pass out the Quiz for participants to complete. This will give you an 
idea of how much they already know. Administering the Quiz early will help you tailor the 
training session and show you areas that should be emphasized. If you decide to administer 
the Quiz at the beginning of the training session, read over the responses while participants 
watch the program.

At the end of the session, have them again complete the Quiz. Compare the results to the 
previous quiz immediately and report on any conclusions you make. You may want to meet 
later with each person individually to discuss his or her particular results.

Presentation Outline
Introduce yourself and the training session. Introduce yourself and the training session. 
Welcome participants and offer a brief explanation of how the session will be beneficial to 
both participants and the organization. Have participants introduce themselves and state the 
department or area in which they work. 

Use an “icebreaker.” True stories relevant to the topic will help relax the group.

Explain the desired outcome of the session. When the participants complete this session, 
they should be able to:

Identify when communication conflicts or misunderstandings are related to different  •
generations.
Develop strategies that facilitate communication across generations. •
Capitalize on generational differences to lead four generations in one direction. •

Overview the session. Explain to the group:
Why the session is being conducted •
When questions may be asked •
How the program will be viewed – either straight through or in segments to allow for  •
discussion
What to expect •
Where they will be able to use this information specific to their organization. •

Introduce the program. Point out what the participants should look for. If portions of the 
program do not apply to your audience, be sure to inform them. 

Make sure everyone can hear and see adequately.
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PrOGraM OuTLiNE
Introduction
This section presents the reality of four generations working side-by-side in today’s workplace. 

Key Points:

Traditionalists (Born 1900-1945) expect respect. Respect for country, family, authority and  •
employer.
Baby Boomers (Born 1946-1964) have the expectation that if you work hard, contribute to  •
the team and pay your dues, you’ll be rewarded.
Generation X’ers (Born 1965-1980) expect to be valued for the talents they bring to the  •
table. They are self-motivated to do the right thing and don’t rely on authority to tell them 
to do the right thing.
Generation Y’ers (Born 1981-2000) recognizes that each person has different talents,  •
experiences and abilities to offer.
Workplaces benefit from different points of view and life experiences. •
Generation gaps in values and communication styles create challenges. •
If generations take the time to learn about the different things they see and value, then the  •
gap can be bridged.

Discussion Topics:

Ask participants how they have benefited from working with people from different  •
generations.
Ask participants for examples of challenges they have experienced because of people from  •
different generations being represented in the workplace.

It’s Generational
This section illustrates the dynamic of the differing priorities each generation has and how 
those differences play out in the workplace.

Key Points:

Priorities between generations tend to be different, but one should remember there are no  •
guarantees. These are trends, not programmed into everyone’s DNA. These trends should 
be used as guidelines.
Traditionalists (also called the Silent Generation and the GI Generation) value loyalty and  •
a uniform-looking workforce. They think of authority in a top-down, hierarchical way. 
They admire dedication and a deliberate, steady pace.
Baby Boomers are somewhat similar, but begin to value individuality a bit more. They  •
don’t have the same knee-jerk respect for authority. They value loyalty and the classic 
image of responsibility. They are driven to win.
Generation X’ers (also called the Baby Bust) value results and the bottom line. They value  •
competence and don’t mind going it alone. They don’t care much about authority. They 
make a decision and move on.
Generation Y (also called Millenial and Echo Boomer) prefers for everyone to work  •
together. They are flexible and creative. They don’t have a lot of patience.
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Discussion Topics:

Ask participants how they feel they fit (or do not fit) their generational demographic. •
Discuss how these generational trends can be useful in growing healthy working  •
relationships.

Make a Connection
This section demonstrates how easily communication can be impacted by generational 
differences.

Key Points:

Recognize that there are generational differences in how people communicate. •
Remember generational differences are not differences of opinion or questions of  •
individual taste. They are differences of experience and perception.
Respect how each generation contributes to the workplace. Each individual perception  •
may be correct based on experience, but no individual perception is complete.
Consider alternatives for delivering, receiving and discovering information. •
Avoid relying solely on non-verbal’s to deliver a message. Be direct and clear in your  •
communication.

Discussion Topic:

Discuss how generational differences impact communication in your workplace. •

Capitalize on Differences
This section encourages participants to move beyond initial perceptions and work towards a 
better understanding of the differences experienced at work.

Key Points:

When a difference of opinion or understanding surfaces, take the time to clarify  •
perceptions. Consider generational trends as a source of those differences.
Remember the differences experienced are not questions of right or wrong. •
When you know you’ve caused offense, apologize, specifically. •

Discussion Topics:

Discuss how to candidly engage in dialogue about generational differences. •
Discuss extending an honest apology. •
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SESSiON SuMMarY
Summarize
One summarizing technique is to review the course objectives with the class. Another 
technique is to ask each participant to summarize what was learned from the training session. 
Ask the participants if they have any final questions.

Administer the Quiz
Before the program, decide which tool to use for assessment. A Quiz has been included in 
this Leader’s Guide. The handbook also includes an easy to score quiz. These assessments are 
excellent tools for determining how much each participant learned during the session.
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Quiz 
Circle the correct answer.
1.  How does the workplace benefit from four generations working side-by-side?

A.  Better coverage of the work day to meet customer’s needs
B.  A contribution of different points of view and life experiences
C.  Conflicts caused by generation gaps provide new ideas
D.  Employees assimilate the values of their co-workers

2.  Which generation expects respect for country, family, authority and employer?
A.  Traditionalists
B.  Baby Boomers
C.  Generation X’ers
D.  Generation Y’ers

3.  Which generation expects to be valued for the talents they bring to the table?
A.  Traditionalists
B.  Baby Boomers
C.  Generation X’ers
D.  Generation Y’ers

4.  Generational priorities are:
A.  Programmed into everyone’s DNA
B.  Trends
C.  Easily changed
D.  Always correct

5.  How can the generation gap be bridged?
A.  Take time to learn about differences
B.  Create teams of employees from the same generation
C. Explain how the differences have evolved with each generation into a more productive 

workforce
D.  Focus on tolerance
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6.  Baby Boomers value:
A.  A uniform-looking workforce
B.  Individuality
C.  Competence
D.  Results

7.  Generation Y’ers:
A.  Tend to be flexible
B.  Like working alone
C.  Are driven to win
D.  Admire a steady, deliberate pace

8.  Generational differences are differences of:
A.  Opinion
B.  Individual taste
C.  Experience
D.  Birth order

9.  What is TRUE about an individual’s perception?
A.  Individual perception paints a complete picture
B.  Individual perception may be correct based on experience
C.  Individual perception is only true when combined with other individual’s perceptions
D.  Individual perception is predisposed by DNA

10.  When you encounter miscommunication at work, what should you consider as a source?
A.  Generational trends
B.  The likeability of the person
C.  How long you’ve been with the organization
D.  How vested you are in the conflict
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POWErPOiNT® PrESENTaTiON OVErViEW 
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Slide 4: Traditionalists (1900-1945)
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Slide 5: Baby Boomers (1946-1964)

 
 
 
 
 

Slide 6: Generation X’ers (1965-1980)

 
 
 
 
 

Slide 7: Generation Y’ers (1981-2000)

 
 
 
 
 

Slide 8: Put it in Writing
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Slide 9: Generational Differences
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HOW TO CuSTOMizE a POWErPOiNT PrESENTaTiON®

The PowerPoint® presentations included on the DVD and CD products are customizable when used 
on a computer loaded with Microsoft PowerPoint® software. (Note: In the following instructions, 
“click” implies a click with your left mouse button. If a “right” click is necessary, it will be so 
indicated.) Microsoft PowerPoint® has many features. The following steps will help you customize  
our presentations quickly.

To customize a presentation:
If the “Customizable Version” icon is displayed on the landing screen, click on this option. If this 
option is not available, click on the PowerPoint® presentation to open it.

Save this presentation to another location, such as your hard drive or a folder on the network.  
You will make your customizations on the saved version.

To add, copy, hide or remove a slide, or to change the order of the slides in    
the presentation:
Click on “View” on the menu bar.

Click on “Slide Sorter” from the “View” menu. Or, under the “Normal” view, you may use the 
“Outline” on the left side of the screen.

To add a slide, place your cursor in front of the slide where you want to add a slide. Click on “Insert” 
on the menu bar. Then, click on “New Slide” on the “Insert” menu. Or, click on the “New Slide” tool 
on the tool bar. Choose a slide format to fit your desired content, and follow the prompts given.

Sometimes it’s easier to copy a slide, and then change the content of the slide than to create a new one. 
To copy a slide, click on the original slide. Click on “Edit” on the menu bar, and choose “Duplicate.” 
A new copy will be created to the right of the original slide. Or, click on “Edit” on your menu bar, and 
choose “Copy.” You may then “Paste” the slide wherever you want it to appear.

To hide a slide from your presentation, but to keep it for future use, right click on the slide you wish  
to hide, and choose “Hide Slide” from the menu. Or, click on the “Hide Slide” tool on the tool bar. 

To remove a slide from the presentation, click on the slide you want to remove. Click on “Edit” on 
the menu bar. Then, click on “Delete Slide” on the “Edit” menu. Or, click on the slide, and press the 
“Delete” key on your keyboard.

To change the order of the slides in the presentation, click on the slide to be moved and while holding 
the mouse button depressed, drag the slide to its new location. Release your mouse button to place  
the slide.

If you wish to change or remove the animation effect as you move from slide to slide:
Double click on the slide you want to change the animated transition on.

Double click on the text box of the slide. A border and white handles appear around the text box. 

Click on “Slide Show” on the menu bar. Then, click on “Preset Animation.” To turn off the effect, 
choose “Off.” If you wish to change the effect, there are many options to consider.

To edit content of any slide:
Double click on the slide you want to change.

Double click on the text box of the slide. A border and white handles appear around the text Type the 
desired changes.

Remember to save any changes made to your presentation! 
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This Leader’s Guide is designed to provide accurate and authoritative information regarding 
the subject matter covered. Sources for this information are believed to be reliable. Because 
of the possibility of human error, the publisher does not guarantee its accuracy, adequacy or 
completeness. We are not responsible for any errors, omissions, misprinting or ambiguities 
contained herein or for the results obtained from use of such information. If legal advice or 
other expert assistance is required, the services of a competent professional should be sought.

This leader’s guide is one of a series of print materials, video, online and DVD programs. 
Each product is the result of painstaking analysis, design, development and production by  
the instructional designers and technical specialists on our staff.

Our catalog is constantly being revised and expanded, so we would appreciate any comments 
on current titles or suggestions for future ones. For further information on any product, or to 
receive a free catalog, call 800-285-9107 or send a FAX to 757-498-3657. Visit us on the Web 
at www.coastal.com.

This guide is for educational purposes only. Nothing herein is to be regarded as indicating 
approval or disapproval of any specific practice or product.

Copyright © 2011 Coastal Training Technologies Corp. Purchasers and renters may copy 
the Quiz found in the leader’s guide when they are used in conjunction with the program. 
Any other part of this product may not be copied by any means or for any reason without 
the written permission of Coastal Training Technologies Corporation. All Rights Reserved. 
Created in U.S.A.
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